
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Matching 
The matching process starts by identifying key locations on the piece to 

match and defining the match strategy. The whole work flow of creating 
matched markers will be discussed, from assigning the line labels or points 
to plotting and cutting the finished  marker. 

 
 
 
 

 
By the end of this lesson, you will be able to: 

• Create  matching lines. 

• Create matching riles for point  matching. 

• Set a repeat for matching. 

• Plot and cut matched markers. 
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Overview of Matching 
AccuMark provides options that can be used to match pattern pieces to fabrics with stripes, 

plaids or motifs. Lines are defined on pattern pieces to indicate the matching locations. The 

label applied to the line determines the type of matching – piece-to-piece or piece-to-fabric. 

 

 

 
The Basics of  Matching Patterns 
Matching a fabric pattern between pattern pieces can be as simple as matching a pocket to a 

stripe pattern on a shirt or as complex as matching all the pieces that make up sofa cushions to 

line up a plaid. First, we will look at some of the terminology that will be used in setting up 

pieces and placing matched markers. 

 
Matching Definitions Related to the Fabric: 

 
 Stripe Repeat – fabric designs that occur at regular intervals along the length of 

the fabric. 

 Plaid Repeat – fabric designs that occur at regular intervals across the width of 

the fabric, from selvedge to selvedge. 

 Offset – the distance from the selvedge or another fabric design to the repeating 

design element. 

Plaid Repeat 
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Matching Definitions Related to the Marker: 

 Grid – lines that represent the repeat of a fabric applied to the marker area as a 

guide for matching pieces. How the grid displays depends on the matching type 

used for the marker. 

 Standard Matching – type of matching where matching locations are determined 

relative to horizontal (stripe) and vertical (plaid) lines on the grid lines. There can 

be up to three stripe and three plaid matching locations defined for a marker 

using Standard Matching. 

 Five-Star Matching – type of matching where matching locations are determined 

relative to “stars” generated at the intersection of the stripe and plaid repeat lines 

and at the center of every four “stars”. There can be one plaid and one stripe 

matching location defined for a marker using Five-Star matching. 
 

 
 

Piece Placement Strategies 
AccuMark can use two different matching strategies to restrict piece placement during marker 

making. These strategies are assigned to pieces during piece setup (see the next section) and 

can be edited during marker making. 

 Piece-to-fabric matching – pieces will only place in relation to the repeating 

design on the fabric. 

 Piece-to-Piece Matching – pieces will place in relation to other pieces in the 
marker. 

 
In addition, one of the following placement relationship strategies is assigned to each matched 

piece: 

 Relative Matching – restricts piece placement so that matched pieces align in 

the same relative position to a plaid or stripe line. 

 Same Matching – restricts piece placement so that matched pieces only align on 

the same exact position of a plaid/stripe line. 

 Symmetrical Matching – restricts piece placement so that matching locations 

are equal distances on opposite sides of a stripe line. Matched pieces will align to 

any plaid/stripe line. 
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Line Matching 
The Line Matching method uses internal lines labeled with numbers to determine placement 

strategy. Matching lines can be added and assigned labels during digitizing or in Pattern 

Design. 

 
Piece Preparation 

Internal match lines are added using the following considerations: 

 Lines are based on critical match points on all pieces.

 Lines must be parallel or perpendicular to the grain line.

 Lines must be assigned a label that is added when the piece is digitized or in Pattern 

Design.

 Only one internal label can be assigned per line.

 To match a star (in Five–Star matching), a piece must have two intersecting match lines.

 Each piece can have more than one matching strategy. For example, a piece can match 

to another piece and to the fabric repeat. Use multiple lines to create additional match 

relationships for a piece.

 The same line label can be used on vertical and horizontal lines.

 
To Create Matching Lines: 

1. Determine all matching locations for pieces. 

2. Draw matching lines on the pieces to be matched. Make sure all the matching lines are 

created in the same direction on all pieces. 

3. Input the matching lines by digitizing or in Pattern Design. 
4. Label the matching lines according to the following chart. 

 
Internal 

Label 
Match Type Explanation Example 

0 Piece–to–fabric 

only 

For pieces that will match directly 

to the fabric repeat. This line does 

not match to another piece with a 0 
matching line. 

Centering a flower on 

a sofa cushion piece 

1 Relative match, 

piece–to–piece 

For left and right piece of the same 

category. The left and right pair is 

defined in the model 

Matching the left and 

right front on a shirt. 

 

    
 

Matching a shirt 

pocket to a front piece 
on a shirt. 

For matching pieces with different 
categories 

Relative match, 
piece–to–piece 

2 – 15 
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In this example, the pocket will match to the repeat of the fabric (line #0). It will also match to 

the front, back and yoke pieces (line #2). The front will also match to its pair created in the 

model (line #1). The placed marker below was made using these same pieces. Because the 

pocket was placed first, all the pieces are matching to the grid intersections. The pocket was 

the only piece that had to match to the repeat. The other pieces had relative matches that 

followed the pocket. 

Ordering Markers with Line Matching 

After the pieces have been assigned the proper lines for matching, the order can be created for 

the marker.  The order is where the repeat information will be entered for the marker. 

To Order a Marker with Line Matching: 

1. Order a marker as you normally would with Easy Order Advanced Layout. 
2. Enter the repeat distance in the Plaid and Stripe fields. This will be the measured 

distance between repeating elements in the fabric design. 

3. If needed, enter the Offset information. Offset 1 is the distance from the selvedge or 

end of the marker to the main repeat. This will create the first grid in the marker. Offset 

2 and Offset 3 are used to create additional matching grids on more complex fabrics. 

The repeat will be the same for all offsets. 
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 Plaid Offset – the distance from the left end of the marker. Always entered as a 

positive value. 

 

 Stripe Offset – the distance between the stripe and the center or bottom of the 

marker. Positive values are measured up from the bottom edge of the marker. 

Negative values are measured down from the center line of the marker. 

4. Process the order normally. 
 

Placing Pieces in a Matched Marker 
As pieces are placed, the matching locations will automatically match to the repeat grid 

according to the match types used. Arrows will display at the match locations that are used 

when a piece is placed. The parameters for matching can be changed in marker making to suit 

different fabrics. 

 

Display Settings for  Matching 
In Easy Marking, some settings can affect the way the pieces are placed on the repeat grid. 

You can also choose to hide or show the internal matching lines. 

To Change the Matching Display Settings: 

1. Open a marker with matching defined. 
2. From the View tab, select Settings in the Display panel. 

3. Make changes to the fields that pertain to matching: 

 Internals – use the drop-down menu to show the internal matching lines. Select 

Full or Default to show the internal lines. 

 Matching (Type) – choose Standard or 5 Star to override the matching type 

defined in the order. When the Settings are saved, the new Matching Type will 

be applied. 

 Use Grid Number – changes the grid used for actively matching pieces. Choose 

1, 2 or 3 from the drop-down menu. Pieces matched to other grids will not be 

affected by this change. 

 Validate for Invision™ or AccuMatch™ – when checked this setting restricts 

pieces to match within the same bite as defined for the cutter. 

 
 

Offset 1 

 
Offset 2 

 
Offset 3 

 
 
 
 

Offset 1 
 

Offset 2 

 
Offset 3 
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 Invision Match – length of the bite used for matching. This information is typed 

in. 

 Matching Grid – controls the display of the repeat grid on the marking work area. 

Choose from the following options: 

 Off – no matching grids will be displayed on the marking work area. 

Pieces will still match to the grids even though they are not visible. 

 Active – only displays the grid selected in the Use Grid Number setting. 

Pieces are actively matching to this grid. 

 All – displays all the grids on the marking work area. The active grid will 

be displayed as a solid line. The other matching grids (if defined) will be 

displayed as dashed lines. 

4. Click Save to store the settings and then OK to close the dialog box. 

 

Changing  the Matching  Criteria in Easy Marking 
The repeat and offset values defined for a matching marker can be changed interactively in 

Easy Marking. Any changes will override the original values. The marker can be stored with the 

new repeat or offset values. 
 

 To change the plaid repeat, go to the Fabric tab and click in the Repeat field in the Plaid 

panel. Type in the new plaid repeat. 

 To change the stripe repeat, go to the Fabric tab and click in the Repeat field in the 
Stripe panel. Type in the new stripe repeat. 

 To change the plaid offsets, go to the Fabric tab and click on the Offset 1 button in the 

Plaid panel to select the correct offset to change (Offset 1, Offset 2, and Offset 3). 

Type the offset distance in the field next to the button. 

 To change the stripe offsets, go to the Fabric tab and click on the Offset 1 button in the 

Stripe panel to select the correct offset to change (Offset 1, Offset 2, and Offset 3). 

Type the offset distance in the field next to the button. 

 

Changing  Placement  Strategies in Marker Making 
The way pieces can be placed in reference to the matching grids can also be changed within 

marker making. Matching can also be disabled using these settings. Only one change can be 

made at a time. 

To Change the Placement Strategies for Matching Lines: 

1. Open a marker with line matching defined. 

2. In the Toolbox, click the Matching icon . 

3. Right click on a piece to change the placement 

strategy. The Match Lines dialog box will display. 

4. Make changes to the available fields to adjust the 

piece placement: 

a. Matching Line direction and number – choose 

from the drop-downs to set which line is being 

changed. 

b. Matching Type – choose what the line should 

match to, from the following choices: 

 Marker – matches the piece to the 

fabric. 
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 Piece LR – matches the piece to its pair (defined in the model; same 

category names).

 Piece LL – matches the piece to another piece with the same line 

number.

c. Stripe/Plaid Alignment – how the piece should match to the repeat grid lines in 

reference to other matched pieces. The field next to this box is reserved for an 
offset amount for pieces that are matched to the Marker (a) and to a Relative (c) 

location. Choose from the following options: 

 Relative – allows the piece to match to a similar matching location in 

the marker to other pieces. 

 Same – restricts the piece to match only to the same repeat line as 

other pieces. 

 Symmetric – matched pieces will be placed at equal distances on 

opposite sides of a stripe or plaid line. 

 None – the piece will not be matched. 

d. Matching Line Display – shows the selected matching line on the highlighted 
piece (Show One) or all the pieces with the same line (Show All). 

e. Same/Sym button – click this button to select the piece to match Same or 

Symmetrically to the selected piece. 

f. Default – click this button to return the settings to the original settings from the 

Order. 
5. Click the OK button to accept the changes and close the dialog box. 

 

 

Point Matching 
This method of matching lets you set up and perform matching based on special point numbers, 

a matching rule table, and fields in the Order. Point matching lets you assign restrictions on the 

placement of pieces relative to each other, relative to the fabric design, or a combination of both. 

 

Piece Preparation 
Match points are used by AccuMark to match pieces with each other and/or to the piece goods.  

 Matching points can be perimeter points or internal points 

 Use as few as possible per piece. A single match point, properly placed in the 

piece, can be used for both piece and fabric matching in both the stripe and plaid 

directions. 
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To Create Matching Points: 

1. Align matching patterns, as they will be sewn together. 

2. Select an area of the product where all pieces are attached and draw a continuous line 

across all pieces. 

3. Draw perpendicular lines to indicate matching for the stripe direction. 
4. If only one line exists, place the match point anywhere on the line. If two lines exist, 

locate one internal matching point at the intersection of these two lines for each piece. 

5. Decide which major piece(s) should be placed before any other pieces in the marker. 

Base this decision on where piece–to–fabric matching is the most critical for the model. 

6. Use the digitizer or Pattern Design to insert the points. 

7. Assign Special Point Numbers to the matching points. Special point numbers should be: 

 Unique to each piece in the model 

 Three or four digit numbers 

8. Save the pieces with the matching points. 
 
 

Cutter Note:  Optional Stop (OpStop) Points 
 

Optional stop points should be assigned to critical match points on pieces that will be cut on a 

GERBERcutter. An op-stop is a type of internal point that causes the GERBERcutter to stop 

before cutting a piece. This enables the person operating the cutter to reposition the cutter 

beam over an exact location on the fabric. 

 

Creating Matching Rules 
Point Matching requires rules to be set up to determine the piece placement strategies. Special 

point numbers and corresponding piece categories are entered in the Matching form. Before 

completing this form, you should know: 

 The categories of the pieces that will be matched 

 The special point numbers assigned to the matching pieces 

 How the pieces will match to each other, and 

 How, or if, they will match to the fabric 

The name of this matching editor is entered in the Order and referenced during marker order 

processing. Each rule in the editor is numbered and contains the following information: 
 

 Match Type – the way the piece will match, either to a Piece or the Fabric. 

 First Piece – the category name and point number found on the first pattern 

piece to match. For piece to fabric rules, enter a number (from the chart below) 

to indicate where the piece should match. 

 
 

     
1 Bottom or Offset 

From Bottom 

No Match or Match 

Relative Plaid 

Must Match to 

Same Stripe to 

maintain match 

location 

Positive: 

Above bottom 

2 Any Plaid or No Match, Match Match Relative Positive: 
 Stripe Repeat Relative Plaid, or Stripe, No Match, or Above or to 
  Match Same Plaid Match Sym to Stripe Right 
    Negative: 
    Below or to left 

Offsets 
Y Match 

(Stripe) 

X Match 

(Plaid) 

Marker Match 

Location 

1st Point 

Number 
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3 Top or Offset 
from top 

No Match or 
Match Relative 

Plaid 

Must Match to 
Same Stripe to 

maintain match 

location 

Positive: Below 
top 

4 Center or Offset 

from Center 

No Match or 

Match Relative 

Plaid 

Must Match to 

Same Stripe to 

maintain match 
location 

Positive: Above 

Negative: Below 

 

 Second Piece – the category name and point number of the piece to match to 

the first. 

 Plaid – the plaid alignment strategy for placing the piece. 

 Stripe – the stripe alignment strategy for placing the piece. 
 

To Create a Fabric–to-Piece Rule: 

1. From the Launch Pad, select Marker Creation, Editors and then Matching. 

2. Enter a Comment, if desired. This field can be used to describe where the rule will be 

used. 

3. Select Fabric for the Match Type. Note that MARKER fills in automatically in the First 

Piece Category field (the point will be matched to the marker or fabric). 

4. In the First Piece section, select 1, 2, 3, or 4 in the Point Number field. Refer to the 

chart on the previous page for these selections. 

5. In the Second Piece section, enter the Category and Point Number of the piece 

matching to the fabric. 

6. In the Plaid and Stripe Type fields, choose an alignment strategy for the piece. 

7. In Plaid and Stripe Offset fields, type a value for offset from the repeat. 

8. From the File menu, select Save or Save As. If Save As was selected, type in a name 

for the file and click Save. 
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To Create a Piece–to–Piece Rule: 
1. From the Launch Pad, select Marker Creation, Editors and then Matching. 

2. Enter a Comment, if desired. 

3. Select Piece for the Match Type. 

4. In the First Piece section, enter the piece Category and Point Number. 

5. In the Second Piece section, enter the Category and Point Number that will match to the 

first piece. 

6. In Plaid and Stripe Type fields, choose an alignment strategy for the pieces. 

7. In Plaid and Stripe Offset fields, type a value for offset from the repeat. 

8. From the File menu, select Save or Save As. If Save As was selected, type in a name 
for the file and click Save. 

 

Ordering Markers with Point Matching 
The order can be created after the point numbers and matching rules have been established.  

 

To Order a Marker with Point Matching: 

1. Order a marker as you normally would using Easy Order Advanced Layout. 

2. In the Step 4 – Fabrics area, click in the field and use the lookup to select the name of 

the Matching Rules to be used in the marker. 

3. Choose the Matching Type: Standard or Five Star. 

4. Enter the repeat distance in the Plaid and Stripe fields. This will be the measured 

distance between repeating elements in the fabric design. 

5. If needed, enter the Offset information. Offset 1 is the distance from the selvedge or 

end of the marker to the main repeat. This will create the first grid in the marker. Offset 

2 and Offset 3 are used to create additional matching grids on more complex fabrics. 

The repeat will be the same for all offsets. 

 Plaid Offset – the distance from the left end of the marker. 

positive value. 

Always entered as a 

 Stripe Offset – the distance between the stripe and the center or bottom of the 

marker. Positive values are measured up from the bottom e ge of the marker.  
Negative values are measured down from the centerline of the marker. 

6. Finish entering the model, size and quantity information. 

7. Process the order normally. 
 

If not all matching fields are visible in Easy Order, select Tools / Options. In the Fabric tab 

ensure the desired Matching options are selected. 
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Marker Making with Point Matching 
After the order has been processed, the marker can be made as requested. Features in Easy 

Marking allow matching criteria to be edited for both the marker and individual pieces. This 

means that one matched marker can be used to create many different markers. 

 
To place a piece in a marker with Point Matching, select it from the menu area and place it in the 

marker as you normally would. As the piece is placed, it will automatically align with the repeat 

grid based on the matching locations and types. The repeat, offset and display information are 

changed the same way as for line matching (see previous sections). 
 

 
 

Disabling Point Matching in Marker  Making 
If Matching is not required on certain pieces which were ordered with matching, it can be turned 

off in Marker Making interactively using the Toolbox function Matching. 

To Change the Placement Strategies for Matching Points: 

1. Open a marker with Point Matching defined. 

2. In the Toolbox, click the Matching icon . 

3. Right click on a piece to change the placement strategy. The Match Points dialog box 

will display. 

4. Make changes to the available fields to adjust the 
piece placement: 

 Marker Plaid – turns piece-to-fabric plaid 

matching ON and OFF. 

 Marker Stripe – turns piece-to-fabric stripe 

matching ON and OFF. 

 Piece Plaid – turns piece-to-piece plaid 

matching ON and OFF. 

 Piece Stripe – turns piece-to-piece stripe 
matching ON and OFF. 

 Default – click this button to return matching 

to the original ordered settings. 

5. Click OK to accept the changes and close the box. 

The Cancel button can be used to exit without 

applying the changes. 
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Plotting Matched Markers 
Match marks can be plotted as small horizontal and/or vertical lines. You can plot match marks 

on a marker by selecting the desired setting in the Match Marks field in the Marker Plot 

parameter table. 

 
To Edit the Plaid Stripe Field in the Marker Plot table: 

1. From the Launch Pad, select Plotting and Cutting and then Marker Plot Parameter 

Table. 

2. Select one of the following options from the Plaid/Stripe field: 

 None – no plaid or stripe marks will be plotted.

 Both – plots both the plaid (vertical) and stripe (horizontal) match marks on all 

four sides of the marker as tick marks.

 Plaid – plots only the plaid match marks as tick marks on the top and bottom of 

the marker.

 Stripe – plots only the stripe match marks as tick marks on the left and right 

sides of the marker.

 Bottom Left – plots the match marks on both the bottom and left side of the 

marker.

 Both Full – plots plaid and stripe match marks as solid lines through the entire 

marker.

 Plaid Full – plots only the plaid match marks as solid lines through the entire 

marker.

 Stripe Full – plots only the stripe match marks as solid lines through the entire 

marker.

3. Click File and then Save or Save As. If Save As was selected, type in a name for the 
file and click Save. 

 


